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Beginner's Guide to Paint Shop™ Pro® 
OVERVIEW 

Paint Shop Pro is an image editing and processing application. It can be used by 

novices, who wish to use its editing and retouching tools to create simple images, 

or enhance their family photographs to display on the Web. For the more 

experienced user, Paint Shop Pro version 8.0 offers many advanced features 

including multi-layer graphics, adjustment layers, vector tools for creating vector 

objects, masks, and animated graphics - but these are beyond the scope of this 

document. 

Note: This guide deals only with Paint Shop Pro version 8 and assumes 

knowledge of Windows® 7. 

ABOUT THIS GUIDE 

The aim of this document is to introduce you to the Paint Shop Pro version 8 

interface and to show you how to use some of its tools. It assumes no previous 

knowledge of any graphical package. Many tasks in Paint Shop Pro can be 

carried out in a variety of different ways and this guide attempts to introduce the 

more common ones. You are therefore advised to carry out the actions indicated 

by the numbered paragraphs 

As with most image editing and processing applications, Paint Shop Pro has too 

many features to be addressed in one document. After working through this 

guide, it is recommended that you refer to the extensive information available 

from the Help menu, in particular the Product Tour, which has interactive 

movies to help familiarise you with the full potential of Paint Shop Pro. 

STARTING PAINT SHOP PRO 

To open Paint Shop Pro, click on the Start button, and then in turn choose: 

All Programs 

Graphics, Design, Web and Media 

Graphics 

JASC Paint Shop Pro 8 
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THE OPENING SCREEN 

When Paint Shop Pro opens, the main program window is displayed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Some of Paint Shop Pro's range of palettes may be visible in the working area 

(eg the Learning Centre, Overview, and Layer palettes). As these are not needed 

at the moment, they can be closed down. (If you wish to re-open them at any 

time, click on the View menu and select them from the Palettes option.) 

TYPES OF IMAGE 

Computer images consist of either raster (also know as bitmap) or vector images 

and both of these can be created in Paint Shop Pro.  It is important however, to 

distinguish between the two. 

Raster (Bitmap) Images 

These consist of individual pixels (picture elements), which define the object in an 

imaginary grid. If an image is magnified, the pixels will appear as square areas of 

colour. A pixel is one point on a graphical image; therefore, if an image has a 

resolution of 320 x 200, it will measure 320 pixels across by 200 down. 

Each pixel also has a "bit/colour depth" which determines how many colours it 

can display. A 1-bit image can display 2 (21) colours, an 8-bit image 256 (28) 

colours and a 24-bit image 16.7 million (224) colours. 

Pixels are composed of light, and are made up of combinations of red, green or 

blue light (RGB) to create the different colours. To change a bitmap image, the 

pixels are edited rather than the object itself. 

Standard toolbar 

Tool Options 
Palette 

Menu bar 

Tools 
Toolbar Materials 

Palette 

Layer 
Palette 

Overview Palette 

Photo 
toolbar 

Learning 
Centre 
Palette 
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Vector Images 

Vector images are defined by the use of lines, curves and their locations. They 

are a combination of objects each of which can be manipulated separately 

without impacting on the rest of the image. Each object "contains" instructions on 

how it should be drawn on screen or on paper, such as size, position, colour, etc. 

Note: Vector graphics are not covered in this document and users should consult 

the on-line help facility for further information. 

CREATING A NEW RASTER IMAGE 

Image Dimensions 

1. On the File menu, click on New. 

In the New Image dialog box, the Presets: 

box contains a range of preset sizes for a 

new image. Click on the arrow to view the 

selection, or create a new image from 

scratch, as described below. 

Images can be created in Centimetres, 

Inches or Pixels.  

2. In the Image Dimensions section, click 

on the arrow under Units. 

3. If the image is to be displayed on a 

monitor, choose Pixels.  

Alternatively, if the image is to be 

printed, (and you know the required 

size), choose Inches or Centimetres. 

4. Now enter the dimensions for the new 

image in the Width and Height boxes. 

Resolution 

It is important to set the correct resolution as one too high will result in an 

extremely large document, with little improvement in quality. However, if the 

resolution is too low, this will produce large pixels resulting in coarse, grainy 

images. 

For images to be displayed on Web pages: 

1. In the Resolution box, enter 72 (pixels per inch). 

For images which will be printed: 

2. Insert a resolution of ¼ to ½ of the printer's resolution. 

Note:  The printer resolution of the Library Printer Copiers is 600 dpi (dots per 

inch) and for the Library Self_Service printers is 1200 dpi, other printers 

may vary. 
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Image Background and Colour 

1. Under Image Characteristics, select the Raster Background option. 

2. Under Color depth: select an option - in most cases it is recommended that 

you choose 16 Million Colours (24 bit), since many of Paint Shop Pro's 

commands require this.  When the image is complete the colour depth can be 

decreased (if necessary) and the file saved in another format. 

Note:  The amount of memory required by the new image is displayed at the 

bottom of the box. 

3. To set the colour of the background, click in the Transparent box (for no 

colour), or click on the Color: box and select the desired colour. 

4. Click on OK. 

A separate new window opens in the workspace with the default name of 

Image1. The magnification of the image is displayed (in this example 100%) and 

it consists of one layer, i.e. the Background.  

SAVING AN IMAGE 

When any changes are made to an image, an * will appear in the title bar next to 

the filename, indicating that the file is unsaved. Always save your work 

frequently. Paint Shop Pro has numerous different formats for saving files; 

however, if you intend making further changes to your image, you should keep a 

copy of it as a Paint Shop Pro file. (Image files in Paint Shop Pro version 8 are 

saved with the extension .pspimage.) Once your image is complete and you wish 
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to publish it (either on the web or for inclusion in a word-processing document) 

you can then save it in the appropriate format. If you are unsure as to which 

format to use, we recommend the following: 

 .gif (Graphics Interchange Format) for drawings, cartoons or graphs. 

 .jpg (Joint Photo Expert Group) for highly detailed graphics, e.g. photos or 

fine art. 

 .png (Portable Network Graphics) for all the above, but not widely recognised. 

Save your file now as a Paint Shop Pro file. 

USING TOOLBARS AND PALETTES 

Note the buttons on the Tools Toolbar at the left-hand 

side of the main window.  Many contain an arrow, 

which indicates that more tools share the same 

button.  

For example, when you click the arrow next to the 

Selection Tool, the Freehand Selection and Magic 

Wand tools become available on a flyout menu. 

When you select a tool on the Tools toolbar, the Tool 

Options Palette (above the workspace) displays 

specific options relevant to that particular tool. 

These need to be set up before you start any task. 

DRAWING AN OBJECT 

Using the tools in Paint Shop Pro is a multi-step process. First the relevant tool is 

selected and then further options are set in the Tool Options and Materials 

Palettes. 

For example, to draw a circle shape, outlined in black and filled 

with colour:  

1. On the Tools toolbar, click on the Preset Shape Tool   . 

Notice that the Tool Options Palette has now changed. 

 

To set the options to draw the ellipse: 

1. Click the Shape list: arrow to display the range of 

shapes. 

2. Choose the Ellipse. 
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3. De-select the Retain style and Create as vector boxes, but leave the Anti-

alias box selected. (Anti-aliasing helps to smooth out the edges of curves and 

corners.) 

4. Ensure the Line style: box displays a solid line. 

5. Click on the Width: arrows to set the measurement to 5.00 - this will be the 

width of the Ellipse's outline. 

The foreground colour (for the outline) and the background colour (for the fill) can 

now be selected. 

SELECTING COLOURS 

The Materials palette at the 

right-hand side of the work area 

is where colours are selected. 

It also includes more advanced 

features such as colour 

gradients, patterns and textures. 

Note:  The Available Colors 

panel (shown opposite) 

displays all the colours 

available in a 16 million 

colour (24 bit) image.  

When an image contains 

less, fewer colours will be 

displayed. 

1. To choose a foreground 

colour, click the left-mouse 

button on Foreground 

Material box.  To choose a 

background colour, click the 

left-mouse button on the 

Background Material box. 

2. Ensure the Color tab is 

selected in the Material 

window and the Texture 

box is empty. 

3. Choose a colour by one of 

the following methods. 

 click anywhere in the wheel 

and then adjust the 

saturation/lightness by 

clicking in the box inside 

the wheel. 

Foreground 
Color box 
 
Background 
color box 

Foreground 
Material box 

Background
Material box 

Color, texture and 
transparent buttons. 

Available 
Colors 
panel 

Color wheel 

Saturation/ 
Lightness box 

Basic Colors 
panel 
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 Click one of the colours in the Basic colors panel. 

 Enter RGB or HSL values. 

 Enter the HTML code for the desired colour. 

4. Click on OK.  The new colours will be displayed in the Foreground and 

Background boxes in the Materials palette. 

5. Move the cursor into the workspace, and while keeping the mouse button 

depressed, drag to form the ellipse.  Release the mouse to create the object. 

Note: Keep the SHIFT key depressed to maintain the aspect ratio. If the result is 

unsatisfactory, click on the undo button and try again. 

6. Remember to Save the file. 

RULERS, GRIDS AND GUIDES 

Rulers, Grids and Guides can be invaluable when creating and aligning drawings 

and image elements. 

1. To display the rulers, click on View and select Rulers. (To change the units of 

the ruler, click on File, Preferences, General Program Preferences. On the 

Units tab, select Centimetres, Inches or Pixels.) 

2. To turn on the grid, choose View, Grid.  (To modify the grid, right-click the 

mouse on the Title bar and choose Change Grid, Guide and Snap 

Properties.) 

3. Guides are moveable horizontal or vertical lines, which can be dragged into 

precise positions on the image.  After displaying the rulers, click on View 

Guides. 

4. Click either the top or the left-hand ruler and drag - a guide will appear, which 

can be moved to any position.  To change the position of a guide, double-click 

on the guide handle on the ruler and type in a new value. 

EXITING FROM PAINT SHOP PRO 

To close a single image file, click on File, Close.  If you have been working with 

multiple image files, click on Window, Close All.  To exit, either click the 

Windows close button or choose File, Exit. 

OPENING AND EXISTING FILE 

Existing files can be opened in the usual way by selecting Open from the File 

menu and then selecting the file. In the Open dialog box, click on Show Preview 

to display the image and its details prior to opening. 
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Opening a File Using the Browser 

The Browser displays files in a way similar to Windows Explorer.  However, while 

the directory structure is displayed on the left-hand side, the right-hand side of 

the window displays the files visually in miniature thumbnail views. This enables 

you to see at a glance all the Paint Shop Pro supported files, without having to 

open them individually. 

1. Click on File, Browse to open the Browser, then navigate to the relevant 

directory to display the associated files. 

2. In the right-hand pane of the Browser window, rest the mouse over a 

thumbnail to display its details. 

3. To open a file, right click on the thumbnail and select Open, or double-click 

with the mouse. 

4. Close down the Browser by clicking on the button. 

CREATING SELECTIONS 

Creating a "selection" in Paint Shop Pro is extremely important as it allows you to 

limit the area on which you work, without affecting the whole image.  A selected 

area of your image may be copied, saved as a separate image, coloured, or have 

numerous special effects applied to it. 

When an area is selected, it contains a marquee - a moving border of black and 

white dashes.  (To clear a selection, click on the Selections menu and choose 

Select None, or press CTRL+D).  

Paint Shop Pro provides three different tools for creating selections, the Selection 

tool, the Freehand selection tool and the Magic Wand.  Each of these tools has a 

different set of options on the Tool Options palette.  As in creating a drawing, 

selecting an object in Paint Shop Pro is a multi-step process.  First the relevant 

tool is selected from the Tool bar, and then further settings are chosen on the 

Tool Options palette. 

Selection Tool 

1. Click on the Selection tool and observe the Tool Options palette.  

 

2. Click on the Selection Type arrow and choose the desired shape of the 

selection, e.g. square, rectangle, circle, ellipse. 

3. Ensure Replace is selected in the Mode box. 
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Feather 

This feature creates a softer edge around the 

selection. Extra pixels are placed on the outside of the 

selection and then "faded" to blend them into the 

background.  

Set a number between 0 (no feathering) and 200 

(maximum feathering) in the Feather box. 

Anti-alias 

This helps to smooth out jagged edges around a 

selection by partially filling the pixels and making them 

semi-transparent, resulting in a smooth outer edge.  

Without anti-aliasing, slanted lines or curves can look 

particularly jagged, as shown in the example opposite.  

Magic Wand Tool  

This tool makes a selection on "content" rather than edges, and is based on 

colour values.  It is particularly useful when you want to select irregular shapes, 

which are similar in colour. You may choose to select on colour (RGB Value), 

Brightness or Hue or opacity. 

1. Click on the Magic Wand tool and observe the Tool Options palette. 

 

2. Ensure Replace is selected in the Mode: box. 

Match Mode 

This determines the criteria that will be used when the Magic Wand selects the 

pixels.  Select one of the options from the following list: 

None - will choose all pixels. 

RGB Value - selects pixels, which match the red, green, and blue value of the 

colour selected in the image. 

Color - selects same colour pixels when you select a colour in the image. 

Hue - selects only the hue of the pixels that match the area at the point of 

contact. 

Brightness - selects surrounding areas with the same level of brightness. 

All Opaque - excludes transparent areas. 

Opacity - selects pixels based on the opacity. 
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Tolerance 

Select a value in the Tolerance box.  When the tolerance is set at the lowest 

setting, only identical pixels are selected.  However, when the number is 

increased, the tolerance becomes greater and similar pixels will be included in 

the selection. 

Freehand Tool 

This is used to create irregular shaped selections using either the Edge Seeker, 

Freehand, Point-to-Point or Smart Edge versions of the tool. The different types 

of selection borders are available from the Selection type: drop down list. In 

addition to the feather and anti-alias options (described previously), sharp edges 

and jagged lines can be smoothed by entering a value between 0 and 40 in the 

Smoothing: box.  

Edge Seeker 

This selects borders between two areas of subtle colour or light. Click to start the 

selection, and then make subsequent clicks around the edge - if you make a 

mistake press the Delete key to take you back to the previous point. Double 

clicking will complete the selection. 

Freehand 

When the Freehand tool is selected, the cursor changes into a lasso 

shape.  

Freehand selections are created by holding down the left mouse button and 

dragging the cursor around an object.  Release the mouse to complete the 

selection. 

Point to Point 

This lasso tool selects in straight lines.  Click to start the first line, and click again 

to change direction.  Double clicking will end the drawing of the selection. 

Smart Edge 

This selects borders between two areas of highly 

contrasting colour or light.  After clicking to start 

the selection, a box forms around the edge as the 

cursor is dragged to the next point.  Click again to 

shrink the box to a line and start the next section.  

Double clicking will complete the selection.  

De-Selecting an Object 

To de-select a selected object, press Ctrl + D on the keyboard, or click on 

Selections in the menu bar and choose Select None. 
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Moving a Selection 

To move a selection, drag it to the new position with the tool used to select it (the 

mouse will change into a four-headed arrow). When in the correct position, press 

Ctrl + D on the keyboard to de-select. The area beneath the "moved selection" 

will now display the current background colour unless you are working on a 

transparent background. 

If you wish to move or modify a selection without affecting the original, first select 

it and then choose Float from the Selections menu. Make the changes and then 

click on Selections, Defloat to return it to a normal selection. 

CHANGING A SELECTION’S COLOUR 

The Flood Fill Tool 

Use the Flood Fill tool to fill a selected area with a new colour, patterns or 

gradients. 

1. Make the selection and then click on the Flood Fill Tool.   

2. In the Materials palette, select a new colour.  

3. Move the  cursor inside the selection and click to fill the area with the new 

colour. 

4. De-select the selection by pressing Ctrl + D on the keyboard, or click on 

Selections in the menu bar and choose Select None. 

If you wish to create a blend of colours flowing in different directions, rather than 

a single colour, click on the Foreground or Background Material boxes, and 

select the Gradient tab.  This contains a variety of ready designed gradients 

(which you can edit) along with a range of patterns and textures all of which can 

create interesting effects. 

ENTERING TEXT 

1. Click on the text tool  and observe the Tool Options palette. 

2. Under the Create as: options, select Floating. 

3. Set the desired Font, Size, Alignments and Font Styles. 

4. To create text without an outline, ensure the Stroke width (pixels) box is set to 

0. 

5. From the Materials palette, select a background colour for the text, and then 

click in the image where the text needs to be placed. 
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6. In the Text Entry window, type 

the text. 

7. Click on Apply when all the text 

is typed. 

At this stage, the text is floating 

above the image and can now be 

dragged into position. 

8. Carefully place the cursor over 

the text, and wait until a four-headed arrow  is 

displayed. 

9. Hold down the left mouse button and then drag the 

text into place.  

10. Release the mouse, and then de-select the text by 

pressing the CTRL + D keys. 

Note:  This form of text cannot be edited at a later date and will need to be 

deleted and re-created if changes are necessary. 

THE ERASER TOOL 

The Eraser tool is used to replace colours in an image.  When an image contains 

only one layer (i.e. the background layer), it acts like a paintbrush, replacing the 

original colour beneath it with either the foreground or background colour, 

depending on which mouse button is pressed. 

If however, your image contains layers and the eraser is applied to one of these, 

then transparent areas are created when the left-mouse button is applied.  The 

eraser effects can be restricted to a particular area by first creating a selection 

within the image. 

1. Select the Eraser tool  and observe the Tool Options palette. 

2. Choose a Shape and Size, and then set the Hardness, Density, Thickness 

and Opacity to 100. 

3. To erase colours on the background, drag the eraser across the image.  

(Holding down the left-mouse button uses the background colour; while the 

right uses the foreground.) 

Note: To erase in straight brush strokes, click the point from where the erasing 

will begin, hold down the SHIFT key and then click the end point. 

As the text is 
typed in the 
dialog box, it will 
also display in 
the image. 
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THE ZOOM TOOL 

The Zoom feature is useful when you need a close up view of a specific area in 

the image, or when you wish to decrease the magnification level and make the 

image smaller. 

1. To increase or decrease the Zoom factor, click on the View menu and select 

Zoom.  You can then choose to zoom in or out by one or five steps. 

2. Return to normal view by clicking on View, and then select Zoom, then Zoom 

to 100%. 

CROPPING AND IMAGE 

The Crop Tool is used to remove unwanted areas from an image.  The area to be 

retained is enclosed inside a rectangle.  The areas outside the rectangle are then 

removed. 

1. Select the Crop Tool  and observe the Tool Options palette. 

2. Hold down the 

left mouse 

button and drag 

over the area 

you wish to 

keep.  This will 

produce a 

rectangle with 

eight resizing 

handles. 

If you make a 

mistake and 

need to de-

select the crop 

area, right click 

with the mouse. 

3. To complete the crop, click on the Apply  

button.  

If the rectangle 
needs adjusting, 
click and drag a 
handle. 
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IMAGE SIZE 

Graphics and images have two types of size associated with them: 

 the size of the image file, as measured in kilobytes (KB) or megabytes (MB) 

 the physical dimension of the image, as measured in pixels, inches or 

centimetres (width by height). 

It is important to note the following: 

 pixels represent one area of single colour and have no set, physical size. 

 resizing can reduce or increase the number of pixels in the image, which in 

turn reduces or increases the file size. 

 resolution is the number of pixels printed per inch (ppi).  More pixels per inch 

result in smaller printed pixels and therefore a smaller printed image.  Fewer 

pixels per inch produce larger pixels and a larger printed image. 

 

 

 

 

 

 

 

 You can also resize an image by changing the image's resolution and leave 

the number of pixels (and file size) unchanged. 

 An image should only be resized once.  (Make a copy and practice on that to 

avoid degrading the original.) 

 Images should be retouched and corrected before being resized. 

 Although an image can be re-sized in a web authoring, or HTML package, this 

will only result in the visible size being reduced, with the physical file size 

remaining the same.  Therefore, if you intend using your image on a web 

page, you should change the size within Paint Shop Pro. 

  

150 ppi 

2” 

 2” 

300 ppi 

1” 

 1” 

The size in pixels remains static, but as 

the resolution in pixels per inch increases, 

the overall dimension in inches decreases 

proportionally. 
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RESIZING AND IMAGE 

Increasing or Decreasing the Number of Pixels in an Image 

1. On the menu bar, click on Image, and then choose Resize. 

When the Resize window 

opens, the current 

dimensions of the image are 

displayed in the Original 

Dimensions section. 

Note: Values displayed in the 

Width: and Height: boxes 

(under Pixel Dimensions and 

Print Size), may not apply to the 

current image 

2. Ensure the Resample using: box 

is ticked, and then select Smart 

Size – this is suitable for most 

types of resizing.  

3. To avoid distorting the image, click 

in the Lock aspect ratio box.  This 

will constrain the dimensions of the 

new image to that of the current. 

4. In the Pixel Dimensions section, 

enter new dimensions in the Width 

and Height boxes – you can 

choose to enter them either as 

Pixels or as a Percentage. 

The Width and Height 

measurements under Print Size will 

adjust accordingly. 

Note: If you want to keep the image’s current print size, ensure the Maintain 

original print size box is selected. However, to compensate for this, Paint 

Shop Pro adjusts the resolution. 

5. Click on OK. 

To Change the Print Size of an Image 

1. Ensure the Resample using: box is empty.  

2. In the Print Size section, choose a measurement and enter new values in the 

Width and Height boxes. 

3. Click on OK. 

To change the resolution only, ensure the Resampling using box is ticked. 
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SCREEN CAPTURES 

A Screen Capture (Screen Shot) takes a picture of all or part of your screen and 

transfers it into Paint Shop Pro where it can then be edited and saved like a 

normal image file. The process involves first setting up the capture, preparing the 

item to be captured and then taking the actual screen shot. 

Note: Material displayed on screens is most likely copyright and you must obtain 

permission from the owner before using the captures. Serious penalties 

apply to infringement of copyright. 

1. Click on the File menu, and select in turn: Import, Screen Capture, Setup. 

2. Select the method of capture.  

 Area- captures a specific 

area of the screen. 

 Full screen- captures 

everything on the screen 

 Client Area- includes the 

contents of the active 

program 

 Window- captures an 

active window 

 Object- captures a particular object within an application such as a toolbar. 

3. Select the required method, and then choose either Right mouse click or 

Hot key (make a note of the assigned key), which will be used to activate the 

capture. 

4. If applicable, and the method of capture allows this, click on Include cursor in 

the Options section to include the mouse pointer in the shot. 

5. Click on Capture Now. The Paint Shop Pro application will now minimise to a 

button on the Taskbar. 

6. Ensure the item to be captured is fully displayed on screen, and then follow 

the instructions below for the relevant type of capture.  

Area:  activate the capture (right mouse click or Hot key as indicated in the 

setup). Position the cursor outside the area to be included, and then click the 

left button and release. Drag the mouse to create a rectangle over the desired 

area and then left click the mouse to complete the capture. The image inside 

the rectangle will be transferred into Paint Shop Pro. 

Full Screen/Client Area/Window: activate the capture (right mouse click or 

Hot key as indicated in the setup) to transfer the image into Paint Shop Pro. 

Object: activate the capture (right mouse click or Hot key as indicated in the 

setup).  Move the cursor over the object to be captured.  When a black border 

surrounds the item, click the left mouse to complete the capture. 
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PRINTING 

Printer resolutions are measured in dots per inch (dpi), while image resolutions 

use pixels per inch (ppi). To calculate the size of a printed image in inches, 

printers divide the image size in pixels by the pixels per inch. Therefore, an image 

measuring 300 x 450 pixels with a resolution of 150 ppi would produce a printed 

image of 2 inches by 3 inches. Images with high resolutions produce smaller 

printouts than images with low resolutions. 

1. To check the printable size of your image, click on the Image menu and 

choose Image Information. 

2. If necessary, increase/decrease the resolution of the image.  (See the section 

on Resizing an Image.) 

Printing a Single Image 

1. Click on File, and choose Print. 

2. Click on the Printer button and select the correct printer.  

3. Select the Properties button and choose the colour or black and white 

options, as appropriate. 

4. On the Options tab in the Print Output section, select Color for colour images 

or Greyscale for black and white.  Further options on this tab allow printing of 

the image as a negative, or applying a background colour. 

5. On the placement tab, choose the correct Orientation. 

6. To print the image at a size other than the original, enter a percentage in the 

Scale box, or select the Fit to page option. 

7. Click on the Print button to print the image. 

Positioning and Printing Multiple Images 

The Print Layout facility in Paint Shop Pro allows you to position and print multiple 

images in a variety of ways.  The images can be manually arranged on the page 

or you can use one of Paint Shop Pro’s templates to simplify positioning and 

placement. 

Note: In order to use the Print 

Layout facility, you must 

have an image open. 

1. Open all the images you 

wish to arrange.  

2. From the File menu, 

choose Print Layout. 

All the open images are 

now displayed as 

thumbnails at the side of 

the window. 
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3. Drag the thumbnails onto the page and position as desired 

4. Alternatively, to use a template, in the Print Layout window click on File and 

select Open Template.  

5. Select a category and 

view the different 

layouts. 

6. Double-click on the 

desired template to 

open it in the print 

layout window. 

7. Drag the thumbnails 

onto the template. 

8. When all the images 

are suitably arranged 

click on File, Print 

Setup and ensure you 

have selected the 

correct Printer and Properties. 

9. Close down the Print Setup box, and then click on File, Print to print the 

layout. 

HINTS AND TIPS 

 Only GIF and PNG files support transparency. If you need to make part of 

your image transparent for displaying on the web, Paint Shop Pro 8 has an 

Export GIF Optimizer facility and useful Wizard to guide you through the 

process. Click on File, Export, GIF Optimizer and then click the Use Wizard 

button. 

 Save your work regularly and certainly after every step. 

 Always make a backup of your file. 

 It is a good idea to close down Paint Shop Pro completely every 30 minutes or 

so. When restarted this will utilise the maximum amount of memory and 

improve the application's performance. 

 After working through this guide, it is recommended that you refer to the 

extensive Help Topics, Learning Centre, Product Tour and Jasc Software 

online, all available from the Help menu, to explore the full potential of Paint 

Shop Pro. 
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